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Introduction

Welcome to Getting Started with MapLogic Layout Manager. This book is intended to help you
get started using the MapLogic Layout Manager extension for ESRI's ArcMap™, and to
illustrate the different procedures and methods involved with using the extension.

What Can You Do With The MapLogic Layout Manager?

“Create map books” is the simplest way to describe what you do with the MapLogic Layout
Manager! Of course it does all kinds of other things which we will talk about later.

Map books are all around us. Most of us have used a road atlas at one point or another in our
life. Many small and large government organizations and private companies create custom
map books regularly. Many municipalities need regularly updated street maps for their
emergency and police vehicles.

In the past, the process of creating a map book was a particularly tedious affair. Each page of
a map book had to be created separately. Creating an index of were things are in the map
book (for example, Main Street...Page 9) was a very long and difficult process.

The MapLogic Layout Manager automates many of the steps in this process, to the point that
creating a professional looking map book is not much harder than creating a single sheet map
in ArcMap.

A map book is, basically, a large map that has been broken down into smaller, more
manageable sheets. But it is more than just a collection of small maps. Each page in a map
book knows its relationship to the other pages in the book (you've seen those little notes on the
edge of a page that says “continued on page...").

Map books usually have a key map. A key map is kind of an overview map of the entire area
covered by the map book showing what page covers each area of a map.

And, of course, map books usually have indexes. Indexes list where you can find a feature on
the map (for example, Main Street...Page 9).

The MapLogic Layout Manager brings all the parts of a map book together in a single product.

Each part of the book is aware of the other parts. For example, if you insert map into your map
pages, all the page numbers are automatically corrected, the map key will automatically update
itself, the listings in the index will correct themselves to accommodate the new page and so on.

But lets not get ahead of ourselves; we will explain how you do all this further along in the book.

Tasks You Perform With The MapLogic Layout Manager

The MapLogic Layout Manager is an extension to ESRI's ArcMap desktop GIS application. It
enhances ArcMap by providing tools to allow you to:

1. Create and store multiple page layouts in a single ArcMap document (Mxd)
2. Create map series in ArcMap
3. Create map books in ArcMap

As part of creating a map book, the MapLogic Layout Manager allows you to:

1. Create map series —a map that is broken into multiple pages on different map
extents
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2. Create thematic series — a map that is broken into multiple pages based on
different layer visibilities

3. Create locator maps — an overview map that highlights the location of the current
page in a series

4. Create key maps — an overview map that lists the page number where you can see
the detailed map of an area

5. Create indexes — a listing of features on the map and what page they are located
on

Of course, there are many more details to each of these steps, which we will explore later on.

Tips On Learning How To Use The MapLogic Layout Manager

This book is intended to help you learn the basics of making page layouts, map series and map
books using the MapLogic Layout Manager and ArcMap. For more detailed information about
the options and parameters in each of the many tools in this extension, refer to the MapLogic
Layout Manager User’'s Manual as well as the online help.

The MapLogic Layout Manager has 4 different license levels; Viewer, Basic, Advanced and Pro.
Depending on the license level that you have purchased, you will have different tools and
capabilities available to you. At each section in this book, you will see notation which will tell
you what license you will need to perform the task being described. The following table will give
you a quick overview of what you can do at each license level. Don’t worry if you aren’t sure
what some of the items listed in the table mean as we will provide plenty of explanation as we
get further into the book.

License Level: Viewer Basic Advanced Pro
zll\l/lexv(\j/)dmerent Layouts in ArcMap document Yes Yes Yes Yes
Preview map series and map books Yes Yes Yes Yes
Print single layouts Yes Yes Yes Yes
Print maps series and map books No Yes Yes Yes
Create/edit layouts and map series No Yes Yes Yes
Create/edit map books No No Yes Yes
Cre_ate location listings in map books (i.e. No No Yes Yes
Main street, page 1)

Anchor elements to specific locations on the

; . : No No Yes Yes
Layout (including two-sided page setups)
Create multi-column location listings in map NoO No No Yes
books
Create multi-layout/multi-layer location listings
in map books No No No Yes
Create multi-template sections in map books
(i.e. Page 9 in a map series uses a different No No No Yes
template from the rest)

The MapLogic Layout Manager is an extension of ArcMap. We are assuming that you are
reasonably familiar with ArcMap and have already learned the basics of making maps using
ArcMap. So if you aren’t quite comfortable with ArcMap, we would suggest that you spend a
little time finding your way around ArcMap. Once you have mastered the process of composing
and printing a map layout, it's a good time to get started with the MapLogic Layout Manager.

Some Basic Terminology
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If you have been using ArcMap, you are used to some of the basic terminology such as layers,
maps, layouts, etc. The MapLogic Layout Manager adds some new objects to ArcMap, which
we need to become familiar with:

Page Layouts: A page layout is a single page map. Up to now, whenever you have been
putting together a map in ArcMap, you have been working on a page layout. An ArcMap
document (Mxd) normally has a single page layout. With the MapLogic Layout Manager you
can have multiple page layouts in the ArcMap document.

Map Series Layouts: A map series layout is a layout that prints over multiple pages. It looks
just like a page layout except that you can print or preview multiple maps using the same
template. As you go from page to page in a map series, it automatically updates the map by
moving the visible area of the map, updating page numbers, etc. This allows you to create a
single layout for a map series that can be tens, hundreds, or thousands of pages long.

Book Layouts: Book layouts can contain multiple page layouts, map series layouts, key maps,
location listings, etc. A map book is organized into sections, each containing different parts of a
map book (for example, a cover, a key map, some map pages, a road index, etc.).

Active Layout: Although you can have multiple page layouts, maps series layouts and book
layouts in your ArcMap document, only one layout can be visible at any time. The layout that is
visible is called the active layout.

Map Series Frame, Thematic Series Frame, Locator Frame, and Key Frame: In ArcMap,
the basic window that show’s map information in your layout is called a data frame. With the
MapLogic Layout Manager, we add 3 new frames to ArcMap. These frames look just like data
frames but add more capabilities to the data frame. For example, a map series frame is a data
frame that knows how to print over multiple pages. We will talk more about each frame later.

Series Text: Series text is just like any other piece of text that you place on your page layout,
except that it knows how to update itself as you move from page to page in a map series. A
good example of a series text is a label showing the page number.

Page Index: A page index is a tabular listing of where features are on a single map (i.e. Main
Street, B3). A page index is placed next to the map.

Series Index: A series index is a tabular listing of where features are in an entire map series
(i.e. Main Street, Page 9 B3). A series index is placed before or after the entire map series.
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City Of Winter Park Road Atlas

- [LOCATOR
FRAME

The above sample shows just a few examples of the types of elements you can add to a layout.
Each element has its own purpose and properties. Each element knows how to update itself
based on its properties, which is what makes the extension so powerful.
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Exploring The MapLogic Layout Manager

Everything you need to get to in order to use the MapLogic Layout Manager extension is in one
of three locations:

The “Layouts” tab in the ArcGIS Table of Contents
The “MapLogic Layout Manager” toolbar
The properties of different layout elements and data frames

The Layouts Tab

The Layouts Tab is a new tab that is added to the ArcMap Table of Contents by the MapLogic
Layout Manager. If the Layouts tab is not visible after you install the extension, you can make it
visible by selecting Tools>Options... in ArcMap’s main menu. Go to the TOC Tab, make sure
Layouts is checked and press the OK button.

Table of Contents |

El% Fage Layoutz
oo (@] Page Layout 1
E Map Senes Lapouts
= Book Layoutz
=50 Sample Map Book
-5 Front Cover
~- @ Cover Lapout
(= [ntroduction
~- @) Intro Lapout
F.ep Map
E F.ep Layout
Map Pages
E First Page Layaout
E Map Senez Layout [Active
- 5] Index OF Boads
First Page Layout
Index Layout

i
3

o
o
i

|

1]
Displa_l,ll SOUCE  Lapouts |

This tab is where you move around the different layouts contained in the Mxd. Double-clicking
on any layout will activate it (make it visible). You can only have one layout active at any time.

Click on any item listed in the Layouts Tab using your right-mouse button and you will see a
menu of things you can do with that item.
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Displa_l,ll Source  |apouts | 3 |E|

This is where you will do most of the work of managing layouts, map series and map books
(adding/removing new books and layouts, changing the order of sections, etc.). Different
commands on these menus are enabled and disabled based on what kind of MapLogic Layout
Manager license you have (Viewer, Basic, Advanced or Pro).

The MapLogic Layout Manager Toolbar

The MapLogic Layout Manager toolbar is a new toolbar that is added to ArcMap by the
extension. It is where you will find all of the tools needed to put together a map book. If the
toolbar is not visible after you install the extension go to View>Toolbars>MapLogic Layout
Manager on ArcMap’s Main Menu to display the toolbar.

MaplLogic Layout Manager |
Layout * Edit * \iew * Insert * |Tools * Help «

EE] Map Seties Frame

EE] Seties Locatar Frame
@ Series Key Frame
E&] Seties Text

il Page Index

Eﬁ Seties Index

a Page Layout

& Series Layout

Map Eooks . 5 Map Book
‘B Eook Section
¥ section Templake

You will notice that the toolbar layout is very similar to ArcMap’s Main Menu. This helps you to
quickly find the right commands in the extension based on where you would expect to find
similar commands in ArcMap.

Different commands in the toolbar are enabled and disabled based on:
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1. What kind of layout is currently active (page layout, map series layout or book

layout)
2. What kind of element is currently selected in the layout

3. What kind of MapLogic Layout Manager license you have (Viewer, Basic,

Advanced or Pro)

Element Properties

When you insert a new MapLogic Layout Manager element (for example a Map Series Frame),
the element is added to the active page layout just as in ArcMap’s Insert Menu. To set the
properties of the element, select it, click the right mouse button and then select “Properties...”
on the popup menu. You can also just double-click on the element.

Data Frame Properties

General I [rata Frame I Coordinate System I [lurmination I Grids
Labelz I Annatation Groups | Estent Rectangles I Frame
Size and Position Map Series I Feature Link

::E] Map Senies Properties [zome properties averride Data Frame properties. ]

Sefies | Adjacent Page Listings I Options I

The lozation of each page in the zenes iz determined by a palygaon [area] laver in the
[ata Frame called the ‘Index Laver'. Each polygon in this layer represzentz a page in
the zenes.

Index 1ayer: I 4P agebtlaslndex j

To zart the pages, select a zart field and order.
[+ Sort the series using this field:
[~ Beverse Order

Fg_Mumber

— Page Scale and Reference Scale Settings

f+ Automatic [Beszt Fit] Ovwerlap: IEI IF'en:ent j
" Fixed Scale 1: |10000
i~ Scale each page using this field: |<N|:|ne> j

To zet a different reference zcale for each page. select a reference zcale hield.

[T Set reference scale using field: |<N|:|ne> j

E ach page can be ratated differently using an angle 22t in a rotation figld.

[T Rotate each page uzing thiz field: |<N|:|ne> j

Fage names are uzed for export file names and lizting pages in T able of Contents.

[T Mame each page using thiz field: |<N|:|ne> j

] I Cancel | Aol

You will notice that the element will have all the normal properties you would expect for that
type of element with an added tab for properties specific to our extension. Modify the element
properties just like you would with any other element in ArcMap.
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Working With The MapLogic Layout Manager

In the next chapters we will go through the basic tasks that you can perform using the MapLogic
Layout Manager. Here is what we are going to do in the next chapters:

1. Create a new page layout in ArcMap
2. Create a new map series layout in ArcMap
3. Create a new map book layout in ArcMap

As you will see we are going to start with some pretty simple tasks and gradually build up to
creating a complete map book.
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Creating A Page Layout In ArcMap

(Basic, Advanced and Pro)

In this section we are going to perform a very simple task of creating a new layout using the
MapLogic Layout Manager. Up to now, whenever you have been using ArcMap, you have
been working with a single map layout. With the MapLogic Layout Manager, the ArcMap
document (Mxd) becomes a multi-layout document. This allows you to store multiple page
layouts, map series layouts and map books inside the document. So the first task we need to
become familiar with is how to create these new layouts in ArcMap.

To begin this task open ArcMap. It doesn’t matter if you create a new map or open one that
you have worked on before.

The very first time you open an ArcMap document after you have installed the MapLogic Layout
Manager you will notice a new tab added to your Table of Contents, called “Layouts”. Click on
the tab so you can see its contents. You will notice a list showing your Page Layouts, Map
Series Layouts and Book Layouts. To begin with the only layout you see in the list is one called
“Page Layout 1 (Active)”.

:x]

EI% Page Layauts
. [8 Page Layout 1 [Active)
falg Map Series Lapouts

----- Book Layouts

Displayl Source | apouts |

By default you always have one page layout in ArcMap. When you see “(Active)” in front of the
name of that layout, it means that it's the one that is currently visible.

So lets go ahead and create a new page layout. In order to do this right-click your mouse on
where it says “Page Layouts” and select “New Page Layout” from the menu that pops up.
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Show Lavout Manager Toolbar,.,

0]
| |
Displa_l,ll Source  |apouts | 3 |E|

You will notice a new item added to the list of Page Layouts called “Page Layout 2". And that's
how you add a new page layout in your ArcMap document.

:xJ

EI% FPage Layouts

Displa_l,ll Source | apouts |

Copying An Existing Layout

What if we don’t want to work on a layout from scratch? If you want to make a copy of an
existing layout and modify it, you can Copy/Paste an existing layout. To do this, right-click on
the layout you want to copy and select “Copy” from the popup menu. Then right-click again and
select “Paste” from the popup menu.
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EI% Page Layouts

E ...... Eap Sell Activake
e fg
Rename...
-4 Boak Lz
Crder »

Faste

Remove...

Displa_l,ll Source | aypouts |

Some other things you might want to do once you've created a new layout:

Moving Back And Forth Between Layouts

Now that we have created the new layout, we need to be able to see it. We call this “activating
a layout”. In order to activate a layout, all you need to do is double-click on its name in the list

or right click on its name and select “Activate” from the pop-up menu. You will notice that Page
Layout 1 will disappear and Page Layout 2 will appear. The page layout list will also update to

show which layout is active.

EI% FPage Layoutz

-[# Page Layout 1 [Active]

k

L[ W
Eﬁ tap Senes Laye M|
... N @ Book Lapouts Rename. ..
Crder
Copy
Paste
Remaove...

Displayl Source | apouts |

Renaming Layouts

Of course, you probably want to name your layouts something that is more descriptive than

“Page Layout 1". To do this, right-click on a layout and select “Rename...".

Removing (Deleting) Layouts
If you would like to remove a layout from your ArcMap document, right-click on the layout you

would like to delete and select “Remove...” from the popup menu.

Once you have created a new page layout, you can edit and print it just like you have been

doing so in ArcMap in the past.

Getting Started with MapLogic Layout Manager
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In the next chapter we are going to create a new type of layout called a Map Series Layout. A

map series layout is very similar to a page layout, except that it prints out a series of map

sheets instead of just one sheet.

Rearranging Layouts

You can always rearrange the positions of a layout in the list of page layouts by right-clicking on

the name of the layout and then going to the “Order” menu.

EI% Fage Layouts
- ~[8 Page Layout 1 [Active)

L. @ p: Activate

E Map < Fename. ..
: Crder Up

Copy

Displa_l,ll SOUCE [ apouts |

Past To Top
e To Bokkarn

Getting Started with MapLogic Layout Manager
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Creating A Map Series Layout

(Basic, Advanced and Pro)

Now that we have learned how to create, copy/paste, activate, edit and delete layouts, let's go
to the next level and create a Map Series Layout.

A map series is always driven by a polygon layer that we call the Index Layer. Each polygon in
the Index Layer represents the boundary of a page in the map series. In this chapter we are
going to use an existing polygon shapefile as the Index Layer. We explain how you can use the
extension to create new Index Layers later in this manual in a chapter called Creating An
Index Layer For A Map Series.

Before we get into the steps for creating a map series layout, we need to show you another part
of the MapLogic Layout Manager extension. In the previous chapter we became familiar with
the “Layouts” tab in the ArcMap Table of Contents. In order to get into some of the more
advanced tasks, we need to become familiar with the MapLogic Layout Manager toolbar.

MapLogic Layouk Manager |

Layouk * Edit * Wiew * Insett * Tools * Help =

If you don't already have the toolbar visible, you can display it by going to
View>Toolbars>MapLogic Layout Manager on ArcMap’s Main Menu.

Now that you know where the toolbar is, lets get started on making a map series. To begin
with, we are going to make a map series of US States using one of ArcMap’s Templates. We
are going to use a template so we don't have to spend time setting up our layers, colors, labels,
etc. This is also a good example of how easily you can take an existing layout and turn it into a
map series. So lets get started by opening a new ArcMap session using the
“ConterminousUSA.mxt” template:
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New 2] x|
by Templatesl Eenerall Industry  USA |Wu:ur|u:| I

— Preview

S| Centralll 54, mxt

=] ConterminausUSA, mist
4] Mortheasternll 52, mat
@ Morthwesternl 54, st
@ Southernl 54, mxt

@ Southwesternl] 54, rxt
8] L1 5 st

@ LS ACounties. rxt

IEEEE ggl IE:'\.-’-'-.pps'\ESFII'\arcgis'ﬁarce:-:eES'\Bin'\Templates"\LlS.ﬂ.'\EDnterminDusLlS.-’-‘-..m:-:t E”l
Create Mew
’V'F D ocument " Template k. I Cancel |

Once you have the template loaded, your ArcMap session should look something like the
following:
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@ _Untitled - ArcMap - ArcYiew O] x|

J File Edit Wiew Insert Selection Tools window Help

IDBE&|F 2RX|o o $|awm g8 &a

J@E}@|E @ Ej ml;le?ﬁ vI||£||i|JLEI':.I‘DLIk" Edit * Miew ™ Insert ™  Too

x| [ ..

El% FPage Layauts -
. [ Page Layout 1 [Active) || %
E Map Series Lapouts .

—_ Caneminouc Unled Bhdc

‘ Displa_-,ll Source  Lapouts | 20| = LI | _’I_I

J Drawing ~ ’TO |Ej£j 1 ||.f3.ria| j |1EI j B I U |é

| [2.16 &.601Inches

Since we are going to make a map series, we need to Copy/Paste the layout from the page
layouts area to the map series layouts area. Just as we showed you in the previous chapter,
right-click the mouse on the layout’s name and select Copy, then move the mouse down to the
Map Series Layouts, right-click the mouse and select Paste. Now that you have a new map
series layout, double-click on its name in the Table of Contents to activate it. If you don’t see
the new Map Series Layout that you have just created, click the little “+” sign next to the Map
Series Layouts area on the Table of Contents to expand the tree. When you are done, your
ArcMap Session should looks something like:
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# _Untitled - ArcMap - ArcView =10 x|

J File Edit Wiew Insert Selection Tools window Help
]DE—“E%|&EEK|-¢W | & |[r20537.778 j|.¢_ﬁf|‘§j|k?J@@

J@E@|E @ E:H EB|25;*»; 'I|§EJLaynutT Edit * Miew * Insert * Too
x| [

|* |

El% Fage Layoutz .
i [d Page Layout 1 pal
EEE Map Series Lapauts T

P e E Page Layout 1 [Active] i

----- Book Layoutz -

.'Displa_l,ll Source La_.r..;.utgl :|E| o lI LI
| prawng ~ [ & 0| O] Al+| 7= |[oia o -] Bz u A

] |0.85 8,47 Inches

At this point we have created a new Map Series Layout, but the layout is just a single sheet
layout. We need to tell the extension how to print this layout over a number of pages.

To complete this task we need to do two things:

1. We need to tell the extension that the map is a map series.
2. We need to set the parameters of the map series.

Converting A Data Frame To A Map Series Frame

To convert the map from a regular map to a map series, we need to select the map frame (data
frame) and then select Edit\Convert Data Frame to Map Series Frame on the MapLogic
Layout Manager toolbar.
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MaplLogic Layout Manager £

—— Llayout * |Edit * View * Insert ™ Tools * Help

@ Convert Data Frame To Map Series Frame

f[i] Convert Data Frame To Thematic Series Frame
; f[ﬁ] Convert Data Frame To Series Locator Frame
1_' ﬁ Convert Data Frame 1o senes key Erame

ﬁ Convert Text Element To Series Text

Hemowve Senies Properties Erom Data Erame

Remove Thematic Series Properties From Data Frame
Remowve Locator Properties From Data Frame
Remowve key Map Properties From Data Frame
Remove Series Text Properties From Text Element

Remove Page Index Properties From Element

Remove Series Index Properties From Element

g
3

RGe SaxShe B e

Add Anchor Properties to Element

Remove Anchor Properties From Element

Section Properties. ..

a
o = B 71 H|£' I A LI ¢ JEuinsher'

By converting the data frame to a map series frame, we are telling the extension that this map
is going to have multiple pages. However, we still haven't told the extension where the pages
are.

Also note that we could create a new map series frame by using the Insert menu on the toolbar.

Setting Map Series Properties

To allow a map series to print over multiple pages we need to set the Index Layer for the frame.
The Index Layer is a polygon (area) layer in your map where each polygon represents a page in
your map series. Since we are creating a map series of US States, we want to set the
boundary of each state to be a page in the series. The MapLogic Layout Manager will then
know to zoom to the boundary of each state as it moves from page to page.

How do we tell the extension where the Index Layer is? When we converted the data frame to
a map series frame, a new tab was added to the properties of the frame. To set the Index
Layer, we need to edit the properties of the frame. To edit the map series frame’s properties,
double-click on the frame or right-click on the frame and select “Properties...”
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# Untitled - ArcMap - Arc¥iew -0 x|

J File Edit Wew Inserk Selection Tools ‘Window Help
JDE"E%H% B2 @ X | | & |[aswm 72 |@|§9J@@
J @ @@| @ E] m BIEEZ "I ||§{|_|¥§| J Lavout * Edt * ‘iew ™ Insett * Too

i _x] | I I 1 I 1 I 1 I I8 I 1 I 1 I | ﬂ
m FPage Layouts

|4

EROUE

oo [d] Page Lapout 1 @] == =
El E@ bap Senies Layouts 1 '||' "
- [@ Page Layout 1 [Active) ] i <X Add Data..
Book Lapouts - % c Chrl
7 B Copy Ckrl+C
T £ Delete Delete
- N ﬂ onyert To Graphics
. % femeeees
I

_- - Candemini
— — Graphic Dperations b
DISFI|E|_'.J| Source  Layouts | 2 E| o lI

ngraup

=

——— Order 3

Jgrawing" h"::}||:|j ﬁjﬂ“-‘*‘-"a' l|é
Mudge 3

Display the properties For the selected element -542470.71 1241 | 3 v
&ligr 2
Distribute [ 3
Rotate ar Flip 2

Properties. ..

You will notice that there is a new tab on the properties window called “Map Series”. Click over
to this tab and from the Index Layer drop down list select “United States”. This is the minimum
amount of information that the extension needs to make a map series. However, we don’t want
just a random set of state maps. Let’s order the series by state name. To do this check the
“Sort the series using this field:” option and then select STATE_NAME from the list of available
fields. Once you have done that, click the OK button to exit the dialog.
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General I Data Frame I Coordinate System I llumination I (Grids I Map Cache |
Annotation Groups I BEdent Rectangles I Frame I Size and Position Map Series

:E] Map Series Properties [zome properties overide D'ata Frame properties. |

Seres | Adjacent Page Listings I Options I Cuztam I:::u:IEI

The location of each page in the zenesz iz determined by a polpgon [area) layer in the
D ata Frame called the 'lndex Layer'. Each polugon in this layer representz a page in

the sernies.

Index layer: ILIniteu:I States j
To zort the pages, zelect a zort field and order.

[+ Sort the series uzing thiz field: STATE_MAME j

[T Beverze Order <Mones -

— Page Scale and Reference Scale Setting: — .E.E‘IJE.E.EHD B

{* Automatic [Best fit] P Cel C T ATE MAME

STATE_FIPS

{” Fixed Scale 1 (c0p FEGION | |

{~ Scale each page uszing thiz field: gaﬂpxgggE!BH -

[~ Set reference scale using field: |<N|:|ne> j

Each page can be rotated differently using an angle set in a rotation field.

L
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You will notice that the map will change to show the state of Alabama, the first state in our map
series.
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We have just created a 51 page map series. Of course there are plenty of options and settings
on the map series properties tab that we have not looked at. There is more information further
in this book about further modifying the map series in a chapter titled “Creating A Better Looking
Map Series”. Here we are just looking at the basics.

Previewing Pages In A Map Series

So, we have a 51 page map series, but how can we look at the rest of the pages in the series?
Well, there are two ways that you can do this. If you have enabled individual page listings in
the Layouts Tab (see View\Series and Book Pages in Table of Contents on the MapLogic
Layout Manager toolbar) a list of pages will be added to the added to the Table of Contents.
You can go to any page in the map series by double clicking on the page (Basic, Advanced and
Pro licenses only).

Another method is to display the Preview dialog and flip through the pages using the dialog.
Select Layout\Preview Pages... from the MapLogic Layout Manager toolbar. Viewer licenses
must always use the Preview dialog to look at the pages in a map series.

MapLogic Layout Manager ]
Lavout = Edit ™ ‘Miew ™ Insert ™ Tools » Help =

m Y| Preview Pages. ..

% Frink. ..

Export. ..
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This will popup the preview dialog which will allow you to flip through the pages of the map
series.
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Printing A Map Series

If you would like to print the map series, select Layout\Print... from the MapLogic Layout
Manager toolbar. You will be presented with a dialog similar to the ones you see in any word
processor which will allow you to print the entire series or just a list of pages.

Alternatively, you could select Layout\Export... from the MapLogic Layout Manager toolbar to
export the maps in all the export formats available in ArcMap.
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That is the basic process of creating a map series. Take some time to look at the other
properties you can set for a map series frame. You will see that there are a lot of options for

refining your series to get the results you need.

In the next chapter we will take map series that we just created and convert it into a map book.
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Creating A Map Book
(Advanced and Pro)

In the previous chapters we learned how to create page layouts and map series layouts using
the MapLogic Layout Manager. In this chapter we will go to the next step in the process which
is creating a map book. Notice that an Advanced or Pro license is required to create a map
book.

How is a map book different from a map series? Well, as we learned in the last chapter, a map
series is a layout that prints over multiple pages. A map book takes a map series and adds to it
all of the other pieces that make it a book. Let's take the example of a road atlas. A road atlas
has a series of pages detailing the roads of a selected region. However, the atlas will have an
overview map on the front or back cover showing what page the detailed map of an area is. It
also usually has an index of road names and what page they are located on. If you just took
these map pages and threw away the rest of the atlas, you would be left with a map series.

The MapLogic Layout Manager organizes a map book as a collection of sections. Each section
contains one or more layouts defining the contents of that section. You may want to think of
sections as chapters in a book.

:x]

% Fage Layouts

--E Map Senes Lapouts

= Book Layouts
ER*MES Foad Atlas

b Overview tap

..... Map Pages
i Foad Index

Displa_l,ll Souce  Lapouts |

The order in which these sections appear in the map book is the order in which they will be
printed. Just like a word processing document, the extension will automatically figure out the
page numbering of the sections based on where they are located in the map book

Now that we have an overview of how map books are stored in ArcMap, lets go get started on
putting together a map book. We are going to build on what we have done in the previous
chapters by creating a map book of US states.

Setting Up The Structure Of A Map Book

To begin with, lets create a new map book. You do this by right-clicking on Book Layouts in the
Table of Contents and selecting New Book Layout.
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Let's say we want our map book to have three sections; the first containing a key map (an
overview); the second containing our map pages; and, finally, an index of interstate highways

and their locations. To add 3 sections to the map book, right-click on our newly created map
book and select New Section three times.
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Just so as not to confuse ourselves, right-click on each section and give it a more appropriate
name. While we are at it, we might as well re-name the map book too.
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At this point we have the general structure of our map book, but the sections are empty. So we
need to define the contents of each section.

Adding A Map Series To A Map Book

Normally, you would create a new layout and setup its map properties to add a new map series
to a book. However, the steps are the same setting a map series layout. So let's make use of
the work we did in the previous chapters by copying our US States map series and pasting it
into the State Maps section. As before, right-click on the layout we want to copy and select
Copy from the popup menu, then right-click on the appropriate section and select Paste.

Since we have already setup the map series properties of the layout, we don’t need to do
anything more to the template for this section.

Also note that the map series that we have copied into the book is totally independent of the
map series that is in the map series layouts section. Even though the two look identical, they
are unrelated at this point. We could go back and delete the map series old map series and it
would have no effect on the one that is now in our map book.

Adding A Key (Overview) Map To A Map Book

Now lets work on creating an overview map. If you remember, back at the beginning of this
whole process we started with a page layout which had a map of the conterminous United
States. In order to simplify our work, lets go back to that layout and copy it to our Overview
Map section. Once you have copied the layout into the Overview Map section, activate it so we
can modify its settings.

At this point, your ArcMap section should look something like this:
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Now that we have a layout for our overview (key) map, let's go ahead and setup its properties
so it will display the page numbers in our map book.

To complete this task we need to do two things:

1. We need to tell the extension that the map is a key map.
2. We need to set the parameters of the key.

To convert the map from a regular map to a map series, we need to select the map frame (data
frame) and then select Edit\Convert Data Frame to Series Key Frame on the MapLogic
Layout Manager toolbar.
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By converting the data frame to a series key frame, we are telling the extension that this map is
going to show on what page a detailed map of each state can be found. However, we still
haven't told the extension what map series this key map belongs to.

How do we tell the extension what map series this key belongs to? When we converted the
data frame to a series key frame, a new tab was added to the properties of the frame. We need
to edit the properties of the key frame and link it to our map series of state maps. To edit the
series key frame’s properties, double-click on the frame or right-click on the frame and select

“Properties...".
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Once the properties dialog is visible, click on the Series Key tab to modify the properties of the
key map. Select the appropriate Section, Layout and Map Series to link the key map to and

click OK.

Getting Started with MapLogic Layout Manager

Page 29



Data Frame Properties llll

Eeneral I [rata Frame I Coordinate System I lurniratiarn I Grids | Labelz |
fnmotation Groups I Extent Fectangles I Frame I Size and Position ~ Seres Key

Series K.ey Properties
k.ep | k.ew Labels I Options I

A Seriez Key Map iz a map of the entire extent of a map zenes with labels showing
the page location of each area. A Senes Key must be inked to a Map Senes
Frame in order to properly label the map.

Section:

I State Maps j
Template:

IF'age Layout 1 j

Map Senez Frame:
Marth America j

<Mones |

k. I Cancel Apply

After clicking OK, you will notice that labels have been added to the map depicting the page
location of each state. You might need to zoom in on the map to see this a little better.
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At this point, we have created an overview or key map for our map book. However, the map
needs some clean up to give it a more professional look. Some of the unnecessary layers and
labels should be removed. The key label text and font might be modified. We will leave these

changes for you to explore. For example, after we cleaned up the map we ended up with a
map that looks like this:
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Now that we have our map series and key map, we will next explore the process of creating an
index of US highways.

Creating A Series Index

The last step in our example map book is to create an index of US highways. This is a two step
process. First we need to create a database of highways and the pages they appear on. We
call this a Location Listing Database. The second step is to take that database and put its
contents in a layout for printing.

Creating A Location Listing Database

To begin the process we need to activate the section in our map book containing the map
series we are going to index. Once the layout is active select Tools\Create Location Listing
Database... from the MapLogic Layout Manager toolbar.

Users licensed at the Pro level also have access to a more advanced tool called the Multi-
Layout/Multi-Layer Indexing Wizard. This wizard is available by selecting Tools\Create Multi-
Layer Index Database... For more information about using this tool please refer to the
MapLogic Layout Manager User Manual.

Getting Started with MapLogic Layout Manager Page 32



% Untitled.mxd - ArcMap - Arc¥iew =10 x|

Eile Edit Wiew Insert Selection Tools Window Help

D@H%Hﬂ g}(|ﬂn|¢||1:3,?13,358 j|£|4§j|h;9J@@

__@@M@mmﬂilm -] | &

:ﬂa | 1 L 1
D Paca | auont |
MapLogic Layout Manager

E| Layout = Edit = ‘Wiew ™ Insett * |Tools  Help =

E| Baok Layouts - ﬁ} Create Grid Index Laver
=l Atas of US Highways 4 % Create Linear Index Laver
- 8] Owerview Ma 1
' B Page Laylzut 1 il ; & Location Listing Database. .,

E| State Maps -
i [d] Page Layout 1
e Highway Index | Register License, ..

E2 Remove all MapLogic multi-page objects From MD. ..

| |E| T Rt — -"||

| H

| ©

| prawng = [ | Of~] A+ = o ~lfo -] B 7z u|A

dl
Displa_l,ll Source | apouts | @O = LI _I

Create a new database of the features locations in th |717621.49 -638579.50 Meters |4.28 6.22 Inches

B

This will bring up the Location Listing Database Wizard dialog. In this dialog we are going to
setup the process for creating the database. We need to define the following parameters:

1. The source for the listings. This will include the map series that we are indexing as
well as the layer inside the series containing the map features we would like to
index.

2. The expression for the listing text. We need to tell the tool where the text for the
listings can be found.

3. Any option that we may choose to implement.

4. A file name where the results should be stored.

The first tab in the Wizard allows us to set the source of our index. Select the North America
map series and the Interstate Hwy layer for indexing.
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Next we need to setup the expression which determines the text of the listing. Click the next
button to go to the Listing Text tab.
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As you can see, the tool is going to save the listing text in a field called Listing. However, we do
not have an expression for the text of the listing. Click the Expression button to continue. You
will be presented with the MapLogic Expression Builder dialog. As you will find out the more
you use the extension, this dialog appears in many locations. Whenever we need to define the
text of a label on the map, a column in our index or any other text that changes from page to
page, we use the MapLogic Expression Builder.

In our indexing example, we want to use the highway route number in our index. Select
ROUTE_NUM from the list of available database fields and click the Add button to add it to the
expression.
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As you can see from the dialog, you can create an expression that combines multiple fields and
other information. However, in our example we are done with the expression. Click OK to
close the expression builder dialog. You should now see the newly created expression in the

Wizard.
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We are not going to modify any of the default options on the dialog, so click Next twice until you
get to the Output tab. We need to tell the dialog where to save the results of our indexing.
Click the folder button and select a name and location to save the database file. Don't forget
where you put this file, since we are going to have to get to it later in the process.

Also, notice that you have the option of creating a small test index to make sure you have set
up everything the way you want. Indexing can be a very long process. The Wizard needs to
examine every page of the map series to determine what features need to be indexed, so it's a
good idea to always run a test before you create the final index. In our example, we are
creating a pretty small index so there is no need to create a test version.
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[T Create a sample databasze of approximately: |2|:||:| listings

Thiz optian will create a zmall zample databaze. |tz good a way to check pour
zettings before creating a full databaze which can take a long time to complete.

“'ou can alzo zave alotb of time by uzing this smaller database while laying out
the fontz, column widths, marging, etc. of the Senes Index frame. Once things
[k, the way you like, load the full databaze into the frame.

[T Create an "Asz |s" databasze

An Az 12" databagze puts the page number and index and row and calurn
labelz it their final form. T his eliminates the need ko link the Series Index to the
M ap Senes which can zignificantly glow down the Senes Index on bookz that
have a large number of pages.

However, with an b |2 databaze, if you change the map book. 2o the map
pages stark on a different page number, or if you change the labelz on pour kM ap
Sernes Frame's index grid, you will need ta recreate the databasze.

Cancel < Back M et = Fimizh

Once you have selected the database file, the Finish button should become enabled. Click
Finish to begin indexing. Note the progress of the indexing on your ArcMap status bar. Once

the process has ended, you will see a table of listings and their page locations.
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You have probably noticed that there are a lot more listings than you expected. You may also
notice that many listings are duplicates, but don’'t worry. Once we put the database in a layout,

these duplicates will automatically be removed.

Now that we have our database, we can go to the next step which is including it as part of our

map book.

Creating A Series Index Frame

To start the process, let’s go to the Highway Index section of our map book. Right-click the
mouse and select New Template. Once the template has been created, go ahead and activate

the template.
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Now that we have created our empty layout, we need to add a Series Index to the layout so that
we can display the contents of our listing database. Select Insert\Series Index from the
MapLogic Layout Manager toolbar.

I & R

L 1 L 1 L 1 L
MaplLogic Layout Manager |

Layouk = Edit = Wiew ¥ |Insert * Tools ¥ Help -«

EE] Map Series Frame

EE] Series Lacakar Frame
@ Series Keyw Frame
E&] Series Texkt

quE'_'I Series Index

a Page Layout

& Series Layouk
Map Books 3

\ GOl AL = s S =l » 2

Once the index has been added to the layout, go ahead and resize it to cover most of the page.

]
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You have probably noticed that ArcMap adds a data frame to every layout. Even though we
aren’t going to be using this data frame, there is no way to delete it. If you delete the frame,
ArcMap will create another. However, don’t worry, as long as we leave the data frame empty, it
won't be displayed at print time. If you would prefer, you can drag the data frame off to the side
so that it doesn’t get in the way when you are setting up your Series Index.

Now that we have resized the Series Index, lets modify its properties. To do this, double-click
on the frame, or right click and select Properties... After the properties dialog is displayed, click
on the Series Index tab to modify the properties of the index.

The first thing we need to do is to tell the index where the Location Listing Database is located.
Click on the folder icon and select the database file we created in the previous step. Once a file
is selected, the dialog examines the contents of the database to make sure it is valid and also
populates most of the parameters in the dialog based on what it finds.

Once we have selected the database file, the next step is to link the index to its parent map
series. Although linking the database to the map series isn’t required, by linking the two, the
extension will correct the page numbers to reflect the position of the map series in the map
book.

For example, suppose Main Street is located on the first page in a map series. In the Location
Listing Database Main Street will be listed as being on page 1. However, suppose that the map
series doesn't start on the first page of the map book. In our example, we have a key map on
page 1 of our map book, so the map series actually begins on page 2 of the book. By linking
the index to the map series, the extension will realize this and correct the listing so that Main
Street is listed as being on page 2 of the book.

To link the Series Index to the Map Series Frame, check the Link Database to Map Series
Frame option and then select the appropriate, Section, Template and Map Series Frame from
the drop-down lists.
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Series Index 1 Properties |

Frame I Size and Position  Sefies Ihdex |

ﬁﬁeries Index Properties
Index Source I Index Laycuutl Displap/Sart I:Irl:lerl Dptions I

A Series [ndex liztz the location of iters it a map zenes [for example, Main Street.. Page
4 B-3]. The index draws on information from a listing database created uzing the ''Create
Location Lizting D atabase' tool.

Lizting Database:

IE:'&M apLogichkaplogic Lapout b anagersDocumentationtHighwayl ndes. dbF ﬂ

[MPORTAMNT: The lizting databaze iz a snapshot of feature locations at the time the
database waz created. Any changes that are made to the map book, GIS datazetz

ar lapers that effect the number and location of features will require the recreation of

the databazel

The listing database can be linked to a Map Senes Frame in the map book. | the
databasze iz inked to a Map Senes Frame, page numberzs will be comected to reflect the
lozation of the map genies in the map book. Faor example, if M ain Street iz on page 1 of a
map =enes but the map senes actually beging on page 5 of the map book, Main Street will
be lizted az being on page 5. Linking alzo allows for more optionz when defining listing
bk,

[+ Link databaze to Map Series Frame:

Section:
IState M apz j
Template:
IF'age Layout 1 j
Map Senez Frame:

Marth America j

<Mone: |
k. I Cancel | Apply |

Next, we need to modify the index layout. The index is displayed as a series of columns
containing the listings and their corresponding page numbers. For each column, you can define
the column width, the font, the background color and many other parameters. In our case we
are only going to modify one item and accept the default values for all the other settings.

To modify the index layout, click on the Index Layout tab.

The only property we are going to modify on this tab is that we are going to set the page
number so that it is corrected for the location of the map series frame. In order to do this, click
on Page in the list of columns and then set the Get Text from Map Series Frame’s Index Layer
Table option.
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Series Index 1 Properties el

Frame I Size and Position  Sefies Index |

l@ﬁeries Index Properties
Index Source  [ndex Lapout | DizplaySart I:Iru:lerl Optionz I

The index iz organized as a series of columns containing different information [the lizting test,
the page number, etc.]. ou can modify the content of each column by changing the
expreszzion defining the column az well zize, symbol, and other azpectz of each column. Pro
wzerz can also add new columns to the layout.

Click on a column to modify its properties:

Liztin Add...

Remove®. ..

* Pro license required to add additional columns to indes.

Column Properties:
Colurnn Texst | Fu:untl Background | SizedMargins I Colurnn Break I Title I
{~ Get text from Listing Databasze file

f* Get text from Map Senies Frame's Index Layer Table
[T uze this option link Index D atabase to a Map Senes Frame]

Compozse column fext uging expression;

$3PAGE_MUKMBER E xprezsian... |

k. I Cancel Apply

This is the only modification we are going to make to the Index Layout. However, you may wish
to explore the different tabs for the column properties to see all the changes you can make to
the column.

The next tab is the Display/Sort Order tab. This is where you determine how the listings will be
sorted and the order in which the columns appear in the index. We are not going to make any
changes to this area.

The final tab is the Options tab. Since we know each highway is going to appear on many
pages in our map book, we are going to make combine the listings to save some space in the
index. Make sure the “Combine multiple listings of the same feature” option is checked and
then select “Separate listing pages using:”. By default, the page numbers are separated with a

comma (“,") which is what we will use.
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Series Index 1 Properties 7] x|

Frame I Size and Position  Senes [ndex |

@ Senes Index Properties
Index Sl:uurcel Index Layl:uutl Display/Sort Order  Ophions |

If a listing appears on multiple pages [for example, kain Street Page 6, Main Street Page
). the liztingz can be combined [i.e. Main Street Page B.83] AMDAOR the text [other than
page humbers and grid locationz] can be dropped from zubzequent listingz.

[+ Combine multiple listings of the same Feature

{~ Separate each listed page by a new line
{* Separate lizted pages using: IJ

[+ If there are more than two listings, only show Frst and last listing

[” Drop text from subsequent rows when listings are the same

[f the zenies index frame iz wide enough, the defined calumn layout will be repeated as
mary times az poszible,
¥ Repeat column layout as many times as frame width will allow

Column 5pacing: Il]_2

[f you have added a break to one of the columnz in the indesx, this option will add a
break before the first listing if the lizting iz not a number.

[~ Add a starting break when First listing on first page iz not numeric

The default page iz the page that iz normally dizplaved when vou aren't previewing the
index pages.

Set default page to: |-|

[f wou would like to zee a zample page of the index before creating the entire index
[wihich can take a long time to generate], zelect the Sample Page option.

[+ Generate a zample index page only

k. I Cancel Apply

These are the only modifications we are going to make to the Series Index.

Click OK to accept the settings. At this point, the extension is figuring out the appropriate text
for each listing in the index, removing duplicate listings, sorting the listings, and then laying out
each page of the index. The extension also determines how many pages will be required to
print the index. Note the progress of the process on the ArcMap Status Bar. Once the process
is complete, you will see your index in the layout.
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Just as a map series, you can preview the rest of the pages in the index by selecting
Layout\Preview Pages... from the MapLogic Layout Manager toolbar. To print the map book,
select Layout\Print... from the toolbar.

This completes our map book creation example. To review our work, we first created a new
map book and added 3 sections to our book. We copied a map series to one of the sections in
our map book. We then created a key map in another section which showed the location of
each page in the book. Finally, we created a database of highway locations and added it to the
last section in our map book.

There are many options for each step of this process that we didn’t cover. For more information
about these options, refer to the MapLogic Layout Manager User’'s Manual.
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Creating An Index Layer For A Map Series

(Basic, Advanced and Pro)

In the previous chapters we created a map series of US states. In order to do this, we selected
the state boundaries as our Index Layer. The index layer is a polygon (area) layer in your map
where each polygon represents a page in your map series.

Here are some characteristics about an Index Layer:

- It must be a polygon layer.

- The polygons don't have to be rectangles. For example, we used the boundary of
each state as the Index Layer for an atlas of the United States. However,
rectangular indexes often provide the best results.

- The polygons don't have to be the same size or the same shape.

- Not every polygon in the layer has to be a page in the map book.

The MapLogic Layout Manager can use any polygon layer as an Index Layer. But what if we
don't already have an index layer? The extension provides you with some tools that will create
grid and linear index layers for you. If the tools provided by the extension don’t meet your
requirements, you can always create your own index layer using the layer creation and editing
tools provided by ArcMap.

A grid index layer is a grid of rectangles covering an area.

A linear index layer is a series of rectangles following the path of a linear feature.

Getting Started with MapLogic Layout Manager Page 46



N

In this chapter we will go through the process of creating a grid index layer. Creating a linear
index layer is similar to creating a grid index layer.

To begin the process, let's go back to the US map that we have been working with throughout
this book. We are going to create a grid over the continental United States similar to the one
displayed above.

Once you have the map open, lets zoom out so we can see the entire boundary of the
continental United States. Select Tools\Create Grid Index Layer...

r ! e
MapLogic Layout Manager | _I

Layout = Edit = View ™ Insert * |Tools * Help =
g

J

]
E | Caonterminou s United Blatl

-

> 4] ]

This will display the Grid Index Wizard dialog. In the dialog we must set the limits of where we
would like to create a grid for (the grid extent), the size of each grid rectangle, and the file that
we would like to store the results in.

In our example we are going to use the visible area of the map for our grid extent. Click on the
Current Extent button. You will notice that the starting and ending coordinates for the grid have
now been set to the visible area of the map.
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Since we are creating a grid that covers the continental United States, we don’t want any grid
cells that are entirely outside US Boundaries. To accomplish, this click on the Don't Create
Empty Grids option and then select the United States layer.

E}!Erid Index Wizard

& Gnd Indexs Laver iz used to create a map senes that covers an
area such az a city or county.

Grid E xtent | Page Size and Order I Page Namesl Olutput I
Set the extent af the arid.

Starting Coordinate [Lowerl eft]:

A -2,474,745.45 EurrentE:-:tentl

T 1,723,712 EE Full Extent |
Ending Coordinate [UpperRight]:

A 2,399,848 57

T 1.435,359.65

[v Don't create empty grnds.

& and is congidered empty unless it contains features
from at leazt one of the following selected layers:

[] Capital Cities

[J uzabln

[]Rivers

[ Interstate Huwy

[ State Bnd

[ Lakes

|Ihited States

[1 Meighbouring Countries

x|

Cancel < Back Mext » Eirmzt

The next step in the process is to set the size of each grid cell and the order that they will
appear in the series. Since our map units are in meters, let's make cells that are 200-kilometer

squares to keep things simple.

Click the Next button to go to the Page Size and Order tab. Select Map Units and enter

200,000 for both the width and height of our grid. We are going to use the default order of the

grid pages which is Upper Left to Lower Right.
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E}Iﬁrid Index Wizard

& Gnd Index Laver iz used to create a map senes that covers an

area such as a city or county,

Grid Extent  Page Size and Order | Fage Namesl Dutput I

—Page Size
The size of each rectangle be can either in map units or
page unitz. |f pou select page unitz, you must alzo zelect a

zrale for each rectangle.
= Page Unitz (Inches)
Width: | 932645691 740924
Height : | B.054 75024343634
Scale: 1: |  20563350.724591
v Map Unitz  (Meters)

"fidth | 200000
Height : | 200000
—Page Order

IJpper Left ko Lower Right

{* Move accross first and then up or down

{~ Move up or down firzt and then accross

=~

Canicel < Back M et =

Eimizt

The next step in the process is to assign page names to each cell in our grid. This is an

optional step and we are just going to take the default values in the dialog. So click the Next

button twice to go to the Output tab.

The Output tab is where we choose a file to store our results in. Notice that you can either
create a new file or update an existing layer with the grid. In our example we are going to

create a new file. Click the folder button and select a file to store the resulting grid.
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HpGrid Index Wizard x|

A Gnd Index Layer iz used to create a map senies that cavers an
area =uch az a city or counky,

Thiz taol will create rectanagles that will cover a zelected area.
Thesze rectangles can be added to an existing laver ar a new
layer.

{+ Create a new Layer:

[C:\Temp\U S Grid.shp ﬂ

i~ Use an existing Layer:

|<NDtSet> j

[T Clearn laver [Select this aption to delete all existing features)

Output Fields:

FPage Murnber: IP‘g_NumI:uer j
FPage Scale: IP‘g_ScaIe j
Fage Marme: IP‘g_Name j

[T Start page numbers aften highest existing nurmber

Cancel ¢ Back [ et = Finizh

Once you have selected an appropriate output file, the Finish button is enabled. Click Finish to
create the grid. After the process has ended, you will notice a new layer in your map displaying

the resulting grid.
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This completes the process of creating a grid index.
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Creating A Better Looking Map Series

(Basic, Advanced and Pro)

In the previous chapters we created a quick map series using the US state boundary.
However, we spent little time on the details of each page in the series. In this chapter we are
going to explore some of the tools provided by the MapLogic Layout Manager that allow you to
further customize the map series. In particular, we are going to learn how to:

1. Add adjacent page labels to each map in the series
2. Add page numbers to the map series
3. Add a locator map to the map series

Adding Adjacent Page Numbers To A Map Series

Adjacent page numbers are labels on the edge of the map that tell users what page to go to if
the map feature they are looking for goes beyond the current page in the map series. The
MapLogic Layout Manager automatically adds these labels to a map series. In fact if you look
closely to the map series that we created earlier, you will notice the labels on the edge of the
map.
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Now lets take a closer look at the options available to us when creating these labels. The
properties of the adjacent page labels are part of the properties of the map series frame. As we
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learned in previous chapters, we edit the properties by double clicking on the Map Series
Frame or right-clicking and selecting Properties...

Once you have the properties dialog visible, select the Map Series tab. You will notice that the
Map Series tab has three sub-tabs. Click on the Adjacent Page Label tab so that we can see
its contents.

Data Frame Properties d |

Eeneral I [rata Frame I Coordinate System I [mination I Gridz | Labelz |
Annotation Groups I Extent Fectangles I Frame I Size and Poziton ~ Map Seres

:E] Map Seniez Properties [zome properties override Data Frame properties. ]

Series | Adiacent Page Listings I O pticns I

A adjacent page listing iz a label that appears on the edae of the map that lists the
neighbaring page(z].

[+ Label map with neighboring pages

Label Expression: |5qos Page Expression. . |
FpADJACENT_PAGE_MUMEER

Symbol Preview: Symbal... |

Helvetica 12

OFfzet from map: ||:|.|:|5
Rotation: [~ Automatic  Top: | — Left: IEIIII =
Battom: [ =5 FRight [o7n =
Maormally, only one page iz listed az adjacent on each side of the map.

[T List all adjacent pages

k. Cancel Apply

As you can see, we have a number of choices when placing adjacent page labels. The first
option is the text for the label. As we have seen before, the text of a label is determined by an
expression. The MapLogic Layout Manager translates this expression into an appropriate label.

By default, the adjacent page label expression is “See Page $$ADJACENT_PAGE_NUMBER” .
Anytime you see something in an expression that starts with $3$, you are looking at a reserved
word. This is a word that the extension understands and substitutes for an appropriate value.
For example, in our case, the actual label might look like “See Page 3.

Why use an expression? Well, this allows you to have total control over what the label says.
Suppose you prefer the label to say “Go To 3”. All you would need to do is to change the
expression to say “Go To $$ADJACENT_PAGE_NUMBER”.
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Now, let's suppose that for our US State map series we would like the label to say something
like “See Mississippi (Page 25)". In this case, we need to create an expression that not only
has the page number, but also the state name. In order to create this expression we need to
extract information from our index layer which has the boundaries of each state.

In our case the expression that we need will look like:
See [STATE_NAME] (Page $$ADJACENT_PAGE_NUMBER)

Anytime we use brackets “[ ]” around a word, the extension interprets this as being the name of
a field in the table. So, in this case we, are telling the extension to look in the STATE_NAME
field in the index layer’s table.

We are going to leave further explanation on building expressions to the User's Manual.
Fortunately, the extension provides you with an expression builder that makes building
expressions much easier. To display the expression builder click the Expression button.

i MapLogic Expression Builder 21

— Reserved Wordz: [page numbers, dates, etc. |

| $34DJACENT_PAGE_MUMBER | add |

Fage number of page adjacent to cunrent page

— Databaze Fields and Formats: [fields from the selected table]

FID | bod |

FID -
AREA fdd
‘CTATE NAME _
STATE FIPS 2. Abs = 3
—5UB_REGION
T|STATE_4BER
POP1530

FOPZ000 i Add

Font Mame and Size. Example: <FMT name="tral" size="18":by text< FNT =

— Expreszion:
Compose an expression by using reserved wordz, database fields, formatting statements and other text.

See[STATE_MAME] (Fage $$40JACENT_PAGE_MUMBER)

Werify |
Help | Cancel k.

The expression builder presents you with a list of reserved words and database fields that you
can drop down into the expression by selecting each item and clicking the Add button. Once
you are done composing the expression, click the OK button to accept the expression.
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We can also change the text symbol used for the adjacent labels. To change the label symbol,
click the Symbol button and select the symbol. In our example, we have selected a red
bold/italic label.

Data Frame Properties 2=
eneral I [rata Frame I Coordinate Sustem I [urrikatiar I [Eridz | Labelz |

Anrotation Groups I Extent Rectangles I Frame I Size and Position ~ Map Series

::E] Map Seriez Properties [zome properties averride Data Frame properties. ]
Senes  Adjacent Page Listings | Options I

An adjacent page lizting iz a label that appearz on the edge of the map that listz the
neighboring page|z].

[+ Label map with neighboring pages

Label Expression: |See [STATE_MAME] [Page Exprezzion... |
$RADJACENT _PAGE_MNUMEER]

Symbol Preview: | Spmbal... I

Helvetica 12

Offzet from map: ||:|_|:|5

Rotation: [~ Automatic Top: [ =l Left IElEI :ll

="
Baottom: [ ﬁ Right: [270 j

Marmally, anly ane page iz lizted az adjacent on each zide of the map.

[T List all adjacent pages

] Canicel Apply

There are also some options about the distance of the label from the map as well as the label

angle. We aren’t going to make any changes to these options. Click OK to apply the label
properties.
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As you can see, the adjacent labels have changed to reflect the new settings.

Adding Page Numbers To A Map Series

In this section we will learn how to add a page number label to our map series or map book.
We accomplish this by adding a Series Text Element to our map. A Series Text element is a
text label that changes from page to page.

To begin the process, lets add the Series Text element to our map series. Select Insert\Series
Text from the MapLogic Layout Manager toolbar.
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You will notice a new text label appearing in the center of the layout with the label “Page 1".

Let's grab the label and move it next to the map title.
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Double click on the label to display its properties. As you can see, there is a new tab on the
text label properties called Series Text. Click on this tab.

Series Text Properties ilil

Teut I Size and Position  Series Text |

E] Senies Text Properties [zome properties overide Text Element properties. ]

A Seriez Test Element iz a text label placed on the page which updates itzelf bazed
an the curent page in the series. The text to changes as the zenes moves from
page to page. Depending on what object the zource of the zenes text iz, different
expressions can be defined for it

Label Source:
{* Get text from the book or series lapout [page number, etc. ]

{~ Get text from a Map Series Frame:

|<N|:|ne> j

" Get text From a Seres Index Frame:®

|<N|:|ne> j

* Thiz optian iz far map boaks which requires an Advanced ar Pra license.

Sometimes a zeries element [Map Series Frame, etc.] doezn't appear on even page
ifi the zerniez. The series text can be et to follow ite parent frame's wizibility.

[+ If parent series frame izn't vizsible, hide the series text as well

Label Expression:

The test in the label iz determined by an exprezsion that extracts information
frorn itz sounce.

Page $3PAGE_MUMBER Expreszian... |

] Cancel Apply

Notice once again that we are using an expression to determine the contents of the text label.
The default expression for the label is “Page $$PAGE_NUMBER?”", which will display the page
number of the current page in the series.

For our example, let’s say that we would also like to display the name of the state along with the
page number. In order to accomplish this, we must first set the series text to get its text from
the map series. Click the Get text from Map Series Frame option and then select the North
America map series. Now click the Expression button and modify the expression to say:

[STATE_NAME]
Page $$PAGE_NUMBER
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Series Text Properties 7| x|
Test I Size and Position  Senies Text |

E] Senes Text Properties [zome properties overide Text Element properties. |

& Seriez Test Element iz a text label placed on the page which updates itzelf bazed
on the current page in the zenes. The test to changes as the zenes moves from
page to page. Depending on what object the zounce of the zenies text iz, different
expreszions can be defined for it

Label Source:

{~ Get text from the book or zenes layout [page number. etc_]

{* Get text from a Map Series Frame:

Marth Amenca j

<Mone:
Marth America

0

* Thiz option iz far map books which requirez an Advanced or Prao license.

Sometimes a zenez element [Map Senes Frame, etc.] doesn't appear on every page
in the zenes. The zenes text can be zet ko follow itz parent frame's vizibiliby,

[ If parent zenes frame izn't vizible, hide the zeries text az well

Label Expression:

The text in the label iz determined by an exprezsion that extracts information
fram itz zource.

[STATE_MAME] Expresszion... |
Fage $3PAGE_MUMEBER

k. I Cancel Apply

You may also want to modify the label font so that it's a little more prominent on the map layout.

Note that we have split the expression over two lines so our label will also be made of two lines.
Click OK to apply your changes.
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As you can see, we now have a label on our map showing the page number and state name. If
you click Layout\Preview Pages... on the MapLogic Layout Manager toolbar, you will notice
that this label changes as you move from page to page in your series.

Adding A Locator Map To A Map Series

The last element we are going to add to our map series is a locator map. A locator map is a
small map that highlights the location of the current page with respect to the rest of the pages in
a map series.

To begin the process of creating a locator frame we are going to Copy/Paste the large map on
the layout and then reduce its size and place it on the maps title area. We could also create the
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map from scratch, however, this way we don’t have to spend time setting up our map layers
and symbols.
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As you can see, the map is currently much to busy for this size. Let's turn off all the layers
other than the state boundaries, remove any labels that are on the map and also zoom out to
the extent of the continental US.

You should end up with a small map that looks more or less like this:
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Now that we have cleaned up the map, make sure the map frame is selected and then click on
Edit\Convert Data Frame to Series Locator Frame on the MapLogic Layout Manager toolbar.
You will get a warning about converting. Click Yes to making the change.
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MaplLogic Layout Manager |
Layouk = |Edt = View * Insett * Tools * Help «
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Now that we have converted the data frame into a series locator frame, we need to set the
properties of the locator map. This basically involves telling the locator where the map series
frame is, and also setting the symbol it will use to highlight the current page.

To edit the locator frame properties double click on the locator map or right-click and select
properties.

Once the properties dialog is visible, click on the Series Locator tab. Now select the North
America map series from the Map Series Frame List.

Data Frame Properties ﬂﬂ

General I Data Frame I Coordinate Syztem I [ lurnination I Gnids I Labels |
Annotation Groups I Eutent Rectangles I Frame I Size and Position  Series Locator

M Senes Locator Properties [zome properties overide D ata Frame properties. ]

Locator | Current Page S_l,lml:u:ull Elptiu:unsl

& Senes Locator Map iz a zmall map placed on the page which shows the location of
the current page in the senesz with rezpect to all the other pages in the zenes. In
order for the locator map to update itzelf az the series moves from page to page., it
muzt be tied to a bMap Seriez Frame.

Map Sernies Frame: |Morth Amernica j
<Mones

Generally a locatar map'sd
you can 22t the map exten
page in the zenes.

[~ Always center the map on the current page in the series

If the map series changes rotation from page to page. the locataor frame can be set o
fallow the zame ratation.

[~ Rotate the locator map along with the map zeries frame

] I Cancel | Apply |

You may also want to click on the Current Page Symbol tab and modify the symbol used to
highlight the current page.

Once you are done with your changes, click OK to apply the properties. Your locator map
should now be highlighting the first page in the map series.
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As you preview your map series, you will see the highlighted area on the map change as you

move from page to page.

This completes our chapter on creating a better looking map series. As you can see, the

MapLogic Layout Manager provides you with many powerful and flexible tools to create

professional looking map books in ArcMap.
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Where To Go From Here

This completes our Getting Started manual. At this point, you should have a good
understanding of how to create basic layouts, maps series and map books. Of course, the
process of creating a quality product that is ready for publication requires much more work.

Remember that we have only given you a brief overview of how to use MapLogic Layout
Manager. There are many more features and tool in the extension compared to what we have
covered in this manual.

For further information about the MapLogic Layout Manager’s tools and properties, refer to the
User’'s Manual and the online help.

If there is one suggestion that we could make about creating map series and map books, it
would be to plan your design. You should remember that every modification you make can
change tens, hundreds or thousands of pages, so take your time and plan things thoroughly.
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Receiving Technical Support

Before you contact MapLogic Support, please make sure you have the product name and serial
number ready.

Online Support Documents

Our online support documents have the answer to many of your questions. Check out our
online help at the following address:

http://www.maplogic.com/support/support.html

If you can't find what the answer to your question online, you can always contact MapLogic's
support staff by e-mail or phone.

E-Mail Support (support@maplogic.com)

To contact MapLogic support by e-mail, send your support requests to support@maplogic.com
or use our online support form at the above Internet address. Please make sure to include a
daytime phone number in case we need to call you.

E-mail support is available to users 24 hours per day (requests for support received after 4:00
PM Eastern Standard Time are handled the next business day.) You must provide your
customer or product serial number and be eligible to receive support in order for us to process
your request.

Telephone Support
To contact MapLogic support by phone, call (407) 657-1250 7:00 AM to 4:00 PM Eastern

Standard Time Monday through Friday. Please make sure you have the product name and
serial number ready to give to the operator.
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Contacting MapLogic Corporation

Contacting MapLogic Corporation

Mailing Address:

MapLogic Corporation

330 West Canton Ave.
Winter Park, FL 32789 USA
TEL: 407-657-1250

FAX: 407-657-7008

Internet: www.maplogic.com

Marketing & Product Sales

To contact the MapLogic Marketing Department, e-mail us at marketing@maplogic.com or call
us at (407) 657-1250 7:00 AM to 4:00 PM Eastern Standard Time Monday through Friday.
Please make sure to include a daytime phone number in case we need to call you.

Technical Support

To contact MapLogic support by e-mail, send your support request to support@maplogic.com
or use our online support form. Please make sure to include a daytime phone number in case
we need to call you.

To contact MapLogic support by phone, call (407) 657-1250 7:00 AM to 4:00 PM Eastern
Standard Time Monday through Friday. Please make sure you have the product name and
serial number ready to give to the operator.
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